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 Figure 1 NanoAnalyze desktop icon.

The program opens a window on the desktop. 

 Figure 2 NanoAnalyze window.
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1 The following functions are located on the Menu bar:

 Figure 3 Menu bar.

• File: Provides access to file and method operations

• Edit: Provides access to the Model Editor, as well as other editing functions

• View: Shows or hides the file tree on the left side of the program window

• Experiment Design: Opens an experiment planning tool for ITC titrations

• Batch Processing: 

• Help: Access to Help files and program information

2 The following functions are located on the toolbar:

• New File: Opens a new file page in NanoAnalyze 

• Open a File: Opens an already-existing data analysis file (*.csc or raw data file) 

• Add a File: Imports an additional raw data file into the file tree 

• Save File: Saves the current state of NanoAnalyze as a *.csc file 

• Model Manager: Opens a window for managing all model fitting files 

• ITC Batch File:

• DSC Batch File:

The Guardian option provides compliance with 21 CFR Part 11. Detailed information is available in the
document “Guardian for Microcalorimetry Software.” 

Guardian for Microcalorimetry functions: 

• Show/Hide Notifications

• Manage Guardian Keys

• Guardian Options



Working with Nano ITC Raw Data Files
The following describes how to open, view, analyze, and print data with Nano ITC raw data files.

Opening a File
1 Select Open in the File menu. 

 Figure 4 File > Open.

2 Use the drop-down list to select the folder that contains the ITC data files.   

 Figure 5 Select folder containing ITC data files.
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3 Select data file type ITC Files (*.nitc or*.jet) from the drop-down list at the bottom of the window. 

 Figure 6 Select data file type.

4 Select the experiment data file that you wish to load, then click Open. 

 Figure 7 Select experiment data.

NOTE: Multiple files can be loaded at the same time if desired. Select the first file 
by clicking on the name with the mouse. Select a range by holding down the Shift 
key while clicking on the last file, or select any number of individual files in any 
order by holding down the Ctrl key while clicking the files with the mouse.
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5 A blank experiment can be performed along with the titration. Blanks include the heat effects that 
result from fluid motion during the injection, along with enthalpies from dilution.Typically the syringe 
is loaded again with the syringe reactant; however, the sample cell is filled with the buffer that was 
used to dialyze the sample. Select Add file.. from the file menu and select the blank file to be loaded. 
You will reference this blank experiment data file in a later step. 

 Figure 8 Select a blank experiment.

6 Click on the titration experiment file in the file tree to load the file for analysis. The data file appears in 
the file tree and a table of the measured heat data appears in the Data Columns tab on the right side of 
the program window. The figure below shows the appearance of the file tree after both the sample and 
blank data files have been brought into NanoAnalyze. 

 Figure 9 Data Columns.
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Analyzing ITC Data
To access data analysis functions, click on the Analysis tab. 

 Figure 10 Analysis.
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Selecting Integration Regions 

Select integration regions automatically by entering the injection time table parameters.

1 Select New baseline by clicking the button in the toolbar in the Analysis tab.

 Figure 11 New Baseline.

The following are the available toolbar functions:

• Undo Zoom: Restores a zoomed-in view to show all of the experimental data

• New Baseline: Sets the integration window start times and width

 Figure 12 New Baseline dialog box.

• Auto Adjust Integration Regions: Integration start and stop times and the baseline nodes are 
automatically adjusted according to signal characteristics. This function can be set as the default 
behavior when an ITC data file is brought into NanoAnalyze. In the Edit menu the “Default ITC 
Settings” option displays a dialog box that contains a checkbox to enable the auto baseline feature 
as well as a selection menu for the default enthalpy units.
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• Resize Integration Regions: This manually sets all integration windows to one common width. 
Individual windows can be adjusted as needed by clicking and dragging the right edge of the win-
dow border.

• Restore Original Baseline: Reset the baseline and integration regions according to default set-
tings

• Subtract Baseline: Subtracts the baseline from the signal data, and assigns the value of 0 
microWatts to the baseline

• Restore Baseline Point

• Remove Baseline Point

• Add and Delete Baseline Pivot Points: Adjusts the path of the baseline

• Add and Subtract Integration Regions: Adjusts the time intervals of the integration regions

• Show/Hide Integration Regions: Toggles between the two functions

• Set Exotherm Display Direction

2 Enter the following:

• Time of the first injection 

• The desired width of each integration region (as a first approximation this can be set to the 
injection interval)

• The injection interval

• The number of injections that occurred (or leave this field blank)

3 The experiment data divides into the integration regions.
Narrow the integration regions by entering a smaller number for the integration region width. 
Typically the heat signal rises from the baseline at some time after the actual injection start time. 
Adding a few seconds to the start time aligns the integration window to the measured heat signal. 

 Figure 13 Integration width.
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The graph now shows the narrower integration regions. 

 Figure 14 Baseline graph.

Examine the baseline in detail by zooming in on a selected portion of the graph.

4 Press and hold the left mouse button at one corner of the zoom region, move the mouse to define the 
opposite corner, and then release. The graph is redrawn to the selected region.   

 Figure 15 Baseline graph.

 Figure 16 Baseline graph.
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Integration regions can be adjusted individually:

1 Magnify the baseline region of interest, if necessary.

2 Adjust baseline pivot points if desired by moving the mouse cursor over the blue circles, then pressing 
and holding the left mouse button. Move the circle to the desired new position and release the button. 
Control handles for the start and end times are at the tops of the vertical gray lines. Adjust these times 
by clicking and dragging with the mouse. 

The buttons above the data graph window provide additional controls for adjusting the integration regions
as well as the appearance of the data display. The baseline pivot points may happen to fall on the peaks or
valleys of the baseline noise. For the best results, the baseline should run through the middle of the noise
band, and the integration windows should be just wide enough to include the peak without any additional
baseline. The experiment data can be examined at high magnification by first zooming in, then scrolling
left to right using the mouse wheel. The integration windows can be adjusted if necessary by clicking and
dragging their starting and ending boundaries. The baseline can be adjusted by moving, adding, or deleting
the pivot points. 

 Figure 17 Baseline graph.

Integration regions are bounded vertically (heat rate axis) by the signal trace and the baseline, and bounded
horizontally (time axis) by the start and end markers. Areas above the baseline are negative (heat was
liberated from the sample). Areas below the baseline are positive (heat was absorbed by the sample).  

3 Select Undo Zoom to review the graph for any additional modifications to the integration regions or 
the baseline fit. Alternatively, navigate along the baseline graph by rolling the mouse wheel (if the 
mouse is so equipped).
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Peak to Width Ratio
On Affinity ITC instruments with serial numbers 25001 and above, experiment data is stored in data files
as raw values that have not yet been processed for smoothing. NanoAnalyze software features three levels
of smoothing that are applied after the experiment data has been collected. The LOESS method of data
smoothing is employed, which has the following advantages vs. an exponential filter:

• The smoothing is applied symmetrically in both directions on the time axis (no skewing to the 
trailing side)

• For a given level of baseline noise result, signal events experience less increase of width at the 
baseline

• Incremental titration experiment injections can be run at shorter time intervals, significantly 
decreasing the total time required for a complete experiment

• The degree of smoothing can be altered for the purpose of signal inspection in order to gain confi-
dence regarding whether an observed feature is only baseline noise that can be excluded from the 
integration region.

NanoAnalyze never alters the original data records. The degree of smoothing can be changed at any time
after a data file is loaded. Select a data file, and then click on Edit > Properties to bring up a dialog box of
data handling controls.   

 Figure 18 Edit > Properties.
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The "Peak to Width Ratio" control sets the degree of smoothing.   

 Figure 19 Properties.

ITCRun software with compatible Affinity ITC instruments also features the same smoothing selection.
When one of these data files is brought into NanoAnalyze, the Peak/Width Ratio is preserved according to
the setting that was in place during the experiment in ITCRun.

Peak/Width Ratio Peak Height
Approximate Peak Width 

(Note: Peak widths are also 
affected by stirring speed)

High Taller 30 seconds

Medium Intermediate 45 seconds

Low Shorter 70 seconds
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Figure 20 illustrates the effect of the three different levels of the control. The same data file was loaded
three times and each was set for a different level of smoothing. The vertical placements were manually
offset to make visible the baseline noise characters.   

 Figure 20 Effect of Peak/Width Ratio Control.
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Figure 21 shows the same set of three differently-set copies of the identical data file after analysis. The
appearance of the data in the three versions differ but the integrated peak areas do not vary by significant
amounts. The titration curves therefore also do not vary to a significant degree as long as baseline
resolution of the peaks is maintained.   

 Figure 21 Invariance of analysis results at various smoothing options.

The matching setting in ITCRun software is accessed via the Settings > Advanced controls tab. The
setting in use at the time of the experiment is saved inside the data file.   

 Figure 22 Settings > Advanced.
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Entering the Titration Data

The sample concentration data and cell volumes are automatically imported when loading a data file that
was collected in ITCRun Version 1.7 or above, or DSCRun Version 3.6 and above. With data files that
were collected using older program versions, enter the experimental data manually as follows (ITC
example shown):

1 Select the Area tab and enter the reagent concentrations. Syringe Concentration is the concentration 
of the reagent that was injected during the experiment. 

Enter the concentration of the reagent that was loaded into the reaction cell in the Cell Concentration 
data entry box.

2 Enter the sample cell volume of the Nano ITC, if not already present.
Analysis of titration experiments requires an accurate figure for the effective cell volume, which varies 
slightly from one instrument to another. For best results, a chemical calibration should be performed to 
establish this figure. Detailed procedures are documented in “Calibration of nanowatt isothermal 
titration calorimeters with overflow reaction vessels”, Neil A. Demarse, Colette F. Quinn, Dennis L. 
Eggett, Donald J. Russell, Lee D. Hansen, Analytical Biochemistry 417 (2011) 247-255.

If a chemical calibration of the cell volume has not yet been performed with a specific instrument, 
these default volumes will be fairly close:

Once the cell volume has been established, enter the figure in the provided entry box in the Settings tab 
of ITCRun. The figure will be saved in the non-volatile memory of the instrument.

Cell Type Affinity ITC Nano ITC

Standard Volume 965 microLiters 950 microLiters

Low Volume 185 microLiters 170 microLiters

NOTE: While not ideal, if available sample volumes happen to be severely 
restricted it is possible to perform an experiment with the sample cell only partially 
filled at the start of the experiment. If this is done, the sample volume loaded into 
the cell plus the reagent volume in the syringe must be less than the sample cell 
volume. No fluid will be displaced from the sample cell during the experiment. In 
these cases, check the Partially Filled Cell box and enter the volume of reactant 
mixture that was loaded into the cell.
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 Figure 23 Area tab.

Subtracting the Blank Experiment
1 Select the blank experiment run from the file tree by moving the cursor onto the file name and 

holding down the left mouse button.

2  Drag the file over to the box labeled Blank (drop blank file here). 
3 If the blank peaks are small, they may also be inconsistent in area. In this case, select the Average 

Area option. Otherwise, when blank peaks are a substantial fraction of the titration run, this indicates 
that the heat of dilution may be relatively large. In this case, the peaks decrease in size during the run 
and the best results may be obtained by selecting the Injection by Injection option. 

 Figure 24 Drag the file to the Blank box.

Hint: Use only one of these methods to enter Blank injection correction values:

• Blank file drop box

• Subtract Constant number entry box

• Blank model (in the Modeling tab)
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Hint: If you do not have a matching blank experiment, an approximate blank correction can be made if the
reaction has essentially reached saturation, meaning that the final peaks are small and have a flat trend
(they are gradually approaching a limiting value). The final injections in the sample experiment may be
effectively the same as blanks if the reaction has gone to completion; in some cases they can also be used
to approximate the blanks of every injection in the experiment. This method applies a constant value from
the Subtract Constant (below Area Correction) window to every injection in the experiment. Be sure to
match the sign of Q as seen in the injection table. Enter an estimate of the final convergence value into the
box labeled Subtract Constant.   

 Figure 25 Subtract Constant.

Fitting a Model to Titration Data

Exporting a Previously-Fitted Model to the New Version of NanoAnalyze

1 Open the existing version of NanoAnalyze and select Edit > Model Editor from the menu.

2 In the model directory tree, right-click on the customized model you wish to preserve.
3 Select Export model... and save the file to a directory of your choice. After exporting all desired 

customized models, exit NanoAnalyze and uninstall the software from your system.
4 Install the new version of NanoAnalyze and start the software. Select Edit > Model Editor from the 

menu.
5 Right-click the Models folder and select Import Model... From the browser window, select the model 

to be imported. Repeat this step for all the models you wish to import.

NOTE: A new database for the data-fitting models was introduced in 
NanoAnalyze version 1.2. If you have created or modified any models while using 
versions prior to 1.2, please follow these instructions to ensure they remain 
available for use with versions 1.2 or higher. Perform these steps before installing 
the new version.
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Fitting a Model Using the New Version of NanoAnalyze
1 Select the Model tab. 

The data points in the graph correspond to the integrated areas of the injection peaks. The first peak is 
typically smaller than the following peaks due to a smaller amount of reagent injected at the first 
interval. (A common practice to prevent reactions from occurring during the thermal stabilizing before 
the experiment is to briefly blot the tip of the syringe with a clean tissue. This introduces an air bubble 
which acts a as a physical barrier to prevent contact between the reagents in the cell and the syringe 
barrel.)  

 Figure 26 Model tab.

2 Select a model to be used to fit the titration data.
In cases where the binding model is unknown, it may be necessary to attempt to fit according to more 
than one reaction model. 

3 Click the control labeled Model to bring up a list of the available models that have been stored in the 
program. 

4 Click the + to show the list of available models. Multiple models may be selected in this window; a 
typical use for this is to combine the Independent model with one of the Blank models. Click OK 
when you have selected the desired model or models. 
Note that some combinations of models can have matching degrees of freedom. One wouldn't 
normally combine the Blank (constant) along with the Blank (linear) model; both contain a constant 

Hint: If you are 
including a blank model, 
be sure that no Blank 
injection corrections 
were added in the Area 
tab.
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term and the two models would share this in an unpredictable way. The sum of the fits, however, 
would be mathematically valid.

Hint: In some cases, having too many degrees of freedom can slow down the fitting process. When this 
happens, several things can help:

• Use the slider controls to obtain an approximate fit

• Temporarily disable some variables from the fitting process

• Adjust the limits of the acceptable ranges of the variables  

 Figure 27 List of available ITC models.

Initial values for the fit parameters are listed above the mathematical description of the model. 

5 Choose the desired fitting model, then click Select to proceed. 
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6 The toolbar items allow you to perform the following:

 Figure 28 Toolbar options.

Removing Outlier Data
1 Move the mouse cursor over any data point that will not be included in the model fitting. The cursor 

changes into a small crosshair when the cursor is placed correctly. 

2 Click the left mouse button to deselect the data point. Deselected points appear as gray dots.

 Figure 29 Deselected point.

Starting a Fit
Click Start Fit to begin the fitting process. The fit process runs a series of attempts, each of which
improves the fit. In some cases, the time limit or the maximum permitted number of attempts expires
before the fit is optimized. If this happens, simply click Start Fit again.
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Adjusting the Model Fitting Behavior
The model is an equation used to describe the experimental data curve. At the bottom of the Model tab is a
graph displaying the residuals (the differences between the data points and the model equation). The
purpose of the model is to fit the equation to the data in such a way that the sum of the residuals is
minimized, meaning that the equation curve follows the data points closely. The equation parameters are
the thermodynamic variables that have been determined.

Quite often, the fitting algorithm will take a path where eventually the minimization cannot improve. This
is considered a local minimum; the best possible fit is the global minimum. There is no guarantee that the
first minimum found will be the global; therefore successive attempts will often deliver a better fit.
NanoAnalyze software will automatically run several cycles of attempts. At any time that the cycling
process halts, the best fit discovered so far will display, even if it was discovered in a previous cycle.

After the model has converged on a preliminary solution, the software runs through successive cycles of
exploration of the parameters. The parameters are adjusted by a random amount, and then the fitting
process starts again automatically.

1 To adjust the model fitting behavior, use the controls described below: 

 Figure 30 Adjust model fitting behavior.

• The drop-down menu labeled Variable Constraint controls how far the parameters randomly 
adjust on each cycle. The Narrow setting restricts parameter changes between cycles to small 
increments, while Wide allows for larger changes. Sometimes a wider change is required in order 
to break out of a local optimum of the fit. A change of the setting takes effect when the fit is started 
and when a new cycle begins after a local minimum is found.

• Fit Tolerance controls the magnitude of the acceptance threshold. When the threshold is met, the 
fitting process halts. Selecting Precise restricts the fitting process to complete only when the qual-
ity of the fit to the data is extremely close, or when the process times out–whichever comes first. 
The Approximate setting allows for more rapid conclusion to the fit process at the possible 
expense of the ultimate quality of the fit.

• The Stop at First Minimum icon on the toolbar will stop the cycling after the next local minimum 
is found. This check box and the two menu selections above can be adjusted at any time, even if 
the model is running.
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2 Press Start Fit to proceed.

 Figure 31 Start Fit.

3 After the best fit to the data is obtained, some points may be revealed as outliers. These can be 
deselected and the fit process started again. If the set of data points is altered by selection or de-
selection, the memory of the previous best fit is discarded.

The fit parameters K (binding constant), dH (enthalpy), and n (reaction order) are listed in the upper right
of the program window and in the parameter table inside the chart area. The chart area can be customized
in a wide variety of ways. The parameter table in the chart can be repositioned by clicking and dragging
with the mouse. Font sizes and other chart features can be adjusted using the extended controls. Click the
bar labeled “Graph Settings” to the right side of the graph area to make the controls available.   
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Working with Nano DSC Raw Data Files
The following describes how to open, view, analyze, and print data with Nano DSC raw data files.

Opening a Nano DSC Raw Data File 
1 Select Open in the File menu.

2 Use the drop-down list to select the folder that contains the DSC data files.
3 Select data file type DSC Files (*.dsc) from the drop-down list at the bottom of the window. Files 

created in previous versions of DSCRun (*.scn) can also be opened.
4 Select the experiment data file that you wish to load, then click Open.

 Figure 32 Select experiment data file.

5 When the data file has loaded and appears in the file tree, click on the titration experiment file in the 
file tree to load the file for analysis. The data file appears in the file tree and a table of the measured 
heat data appears in the Data Columns tab on the right side of the program window.

NOTE: Multiple files can be loaded at the same time if desired. Select the first file 
by clicking on the name with the mouse. Select a range by holding down the Shift 
key while clicking on the last file, or select any number of individual files in any 
order by holding down the Ctrl key while clicking the files with the mouse.
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6 A buffer scan experiment is often performed along with the sample scan. Buffer scans include the heat 
effects that result from heat flow changes strictly due to an individual buffer. For a buffer scan, 
typically the sample cell is loaded with the buffer that was used to prepare the sample. Select Add file.. 
from the File menu or toolbar and select the buffer scan file to be loaded. You will reference this buffer 
scan experiment data file in a later step.

 Figure 33 Buffer scan.Analyzing DSC Data 

To access data analysis functions, click the Analysis tab.

 Figure 34 Analysis tab.
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Automatically Subtracting the Buffer Scan
To automatically subtract the buffer scan from the sample data, perform the following steps:

1 Select the blank experiment run from the file tree by moving the cursor onto the file name and 
holding the left mouse button down. 

2 Drag the file to the box labeled Blank (drop blank file here). 

 Figure 35 Drag the file to the Blank box.

3 If it has not already been entered, fill in the Conversion to Molar Heat Capacity information.   
a Enter the volume of the sample cell in the Volume (ml) data entry box. This value is typically 0.30 

and will always be the same number for an individual instrument.

b Enter the concentration of the sample in the Concentration (mg/ml) data entry box.

c Enter the Molecular Weight in kilodaltons in the MW (KD) data entry box.

d Click the box preceding the PSV (Partial Specific Volume) data entry box. A check mark appears. 
A PSV value of 0.73 is typical for most proteins in aqueous buffers. Adjust this value as needed for 
other buffer systems.

e Click the box preceding Convert to MHC to place a check mark in the box.  

 Figure 36 Convert to MHC.
Page 25 of 114



f Click Update. The displayed data automatically transforms and the Y scale now displays in 
kJ/mol*K. 

 Figure 37 Data entry field group for conversion to molar heat capacity.

Selecting Integration Regions
1 Set the baseline range by moving the cursor into the graph display area. The cursor becomes a plus (+). 

Place the + on the left of the peak where you want to start the pre-transition baseline, hold down the 
left mouse button, drag the cursor to the right to highlight the baseline range and set the post-transition 
baseline to be considered, and then release the mouse button. The slider controls below the graph can 
be used to visually zoom into a region of interest on the temperature axis. If desired, the upper and 
lower temperature limits of the data to be analyzed can be adjusted by dragging the end of the gray bar

 Figure 38 Highlight the baseline range.
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2 Select the Integration Baseline tab.

 Figure 39 Integration Baseline tab.

3 The following functions are located on the Integration Baseline toolbar:

 Figure 40 Integration Baseline toolbar.

• Add Baseline or Intersection object

• Delete the selected baseline object…

• Settings
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4 Set the pre- and post-transitional baseline by moving the cursor into the graph display area. The cursor 
becomes a plus (+). Place the + on the left of the peak where you want to start the pre-transition 
baseline, hold down the left mouse button, drag the cursor to the right to highlight the baseline range 
and set the post-transition baseline to be considered, and then release the mouse button. 

 Figure 41 Set the pre- and post-transitional baseline.

5 When the mouse button is released, the preliminary baselines are fitted. The dashed lines are the Pre 
and Post baselines, the red solid line is the overall baseline with a smooth transition, and the gray 
circles represent “handles” that can be used to adjust the baseline slopes and curvature. There are two 
handles for a linear fit; higher order models will have additional handles.

6 Adjust the baseline fits by moving the handles within the chart. In the example in Figure 42, the 
second-order baseline on the right was adjusted to remove the curvature. Note that the handle can be 
moved out beyond the actual post baseline region, for ease of accurate adjustment. The enthalpy is 
calculated on a molar basis at this point. 
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7 Manually adjust the pre- and post-transitional baseline by clicking and dragging the handles to give a 
sigmoid curve baseline.

 Figure 42 Manually adjust pre- and post-transitional baseline.

Fitting a Model
1 Select the Modeling tab. The following toolbar functions are available:

 Figure 43 Modeling toolbar.

• Start Fit: Starts the model fitting process

• Stop Model Fit: Stops the model fitting process 

• Fit Settings: Set/Adjust the model fitting parameters (Max fit time (s); Precision; Maximum 
iterations)

• Variable Constraint: Adjusts the permissible size of changes of parameter values that are allowed 
between fitting cycles

• Fit Tolerance: adjusts how close the fit must be before declaring the fitting to be complete

• Stop at First Local Minimum: If desired, activate the button so that during the fitting, when the 
first local minimum is reached, iterations will stop on the first occasion that a minimum of the fit 
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residuals is found. When activated, there will be a blue frame around the button. If not activated, 
the fitting continues until other exit criteria are met

 Figure 44 Activated Stop at Next Local Minimum control.

• Full Screen Display

• Subtract Baseline

• Add Tm Region to be Used in the Fit

• Delete Tm Region

• Export to File

• Export to Clipboard

• Print

• Create Overlay Graph

• Save Current Settings as the Graph Default

• Reset Graph Settings to Defaults

• Move Results Box: The thermodynamic results box can be moved to any convenient position in 
the graph by clicking and dragging with the mouse cursor. The font size may be changed in the 
Graph Settings pop-out menu at the right side of the window.

2 Click the asterisk * under Model to select the appropriate fit model.

 Figure 45 Click the asterisk (*).
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3 Click the control labeled Model to bring up a dialogue box that lists the available models that are 
stored in the program. Click the + to show the list of available models.

 Figure 46 Model Manager.

4 Highlight the desired fitting model, then click Select to proceed. Multiple models can be selected 
together by holding down the Ctrl key while clicking on the second selection. 

5 Available models are:

• Two State: Typically used for single transition peaks

• Two State Scaled: Typically used for single transition peaks and particularly useful in adjusting 
protein concentrations in the cell

• General: Typically used for single transition peaks when calculation for heat capacity is required

• Gaussian: May be useful when analyzing multiple overlapping transitions.

• Independent Non-Twostate: Use this model to analyze systems that unfold in the following path: 
Native > Intermediate > Unfolded.
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 Figure 47 Models.

Multiple models may be selected in this window, and multiple instances of a model may be included. 
A typical use for this is to model multiple transitions. Click OK when you have selected the desired 
model or models. 

Hint: In some cases, having too many degrees of freedom can slow down the fitting process. When this 
happens several things can help:

• Use the slider controls to obtain an approximate initial fit

• Temporarily disable some variables from the fitting process

• Adjust the limits of the acceptable ranges of the variables

Be sure to run a final automated fit with all parameters enabled. In particular, it is often helpful to 
impose strict limits on the available range of Tm for each model.
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6 Place a check mark in the Subtract Baseline box.

 Figure 48 Select Subtract Baseline.

7 Click Start Fit. The red line represents the fitted model, and the calculated thermodynamic data 
updates in the Variables section of the screen. 

 Figure 49 Thermodynamic data.

8 The final calculated data displays in the fit parameters box at the top of the data analysis window and 
in the data box inside the graph. To adjust any starting numbers, go back to the MHC Conversion and 
Integration Baseline tabs and make desired changes, then refit with the model.

9 The Residual Plot displays at the bottom of the fitted graph. This displays how close or far away the 
fitted curve is from the actual raw data.
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DSC Batch Processing Mode
NanoAnalyze can rapidly perform simple analyses on groups of DSC data files with the Batch Processing
feature. Basic thermodynamic values are calculated and MHC conversion is available. Batch processing
provides a rapid preview of the basic DSC experimental results Tmax, ΔH and ΔS. Experiments that
warrant further, more detailed attention can subsequently be modeled in the Modeling tab of NanoAnalyze.
All processing parameters and initial thermodynamic results that result from batch processing are passed
back to the individual data files for convenience.

1 First, load a collection of files into NanoAnalyze. Multiple files can be selected as a group by using the 
standard controls within the File > Open or File > Add Files dialog boxes. To open a group of files, 
click the first file to select it, then use Shift-Click on the final file in the set (hold the Shift key while 
clicking the mouse button). All the files in the range will be highlighted. Alternately, individual files 
can be added to the multiple selection by using Ctrl-Click for each file (hold down the Ctrl key while 
clicking the mouse button). Then click Open. Check the file tree on the left side of NanoAnalyze to 
verify that the desired set of files for batch processing has been loaded.

 Figure 50 Load files (left figure), file tree (right figure).
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2 Select Batch Processing>DSC from the menu bar.

 Figure 51 Entering Batch Processing mode.

The Batch Processing dialog box displays. The window is divided into three sections:

 Figure 52 Batch Processing dialog box.

• The group definition area contains tools for assembling and previewing groups of files. 
Groups are displayed in the space below the Groups toolbar after the groups have been 
defined. The group is a tool to collect files which are to be processed in a similar way, com-
pleting the processing with a single click without duplicated effort. It is easy to set common 
parameters for the group but individual files can be assigned any unique settings as required. 
The results can be graphically previewed together as a set, and Overlay Graphs can be made 
for each group.

• The process parameters area is the data entry control to set the processing parameters for the 
selected file or sets of multiple files.
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• The file table area displays the values of the process parameters along with the thermodynamic 
results from the processing. The scroll bar allows viewing of every column in the table. For 
convenience the file name always remains visible.

 Figure 53 Group icons

3 To assemble the groups, click the green + icon at the upper-left of the DSC Batch Processing dialog. 
The DSC Group Items dialog displays.

 Figure 54 Group Definition dialog.

A Select the set of files that logically belongs together as a Group. The standard multiple-selection 
controls Shift-click and Ctrl-click are available.

Add group

Edit group

Delete group

Create raw data overlay graph

Create corrected data overlay graph

Create corrected data overlay graph
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B Click the right arrow button to add the selected files to the group. The labels for these files will 
moved from the Unassigned window (left side) over to the Group items window (right side).

C Files that have been assigned into the group will appear on the right side. If any files were 
accidentally added that do not belong to the group, they can be deleted by first selecting them on 
the Group side, then clicking the left arrow. The file labels will be removed from the Group 
window and will reappear in the Unassigned window.

Figure 55 shows a group that is partially defined and is ready to add more files.

 Figure 55 Defining a Group.

D If multiple Groups are to be created, provide a unique name for each in the entry box at the lower 
left (shown in Figure 55).

E When the list of files on the right side is complete and correct, complete the creation of the group 
by clicking Add Group (shown in Figure 55).

F If desired, more Groups may be defined by following the above steps A through E again. When all 
desired Groups are created, click Done on the lower-right portion of the screen.
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When the desired groups have been created, click Done to return to the Batch Processing window. 
Figure 56 shows the layout of the window and the sections of related data file table editing controls.

 Figure 56 Batch processing controls.

4 Next, define the process parameters. The processing variables can be set up the same for all members 
of a Group, or with individualized settings for any member as needed. The first step is to select the 
lines in the table that are to be edited.
Several of the icons at the left side of the File Table Area provide functions that assist with the file 
selections. 

 Figure 57 Table functions.

Mouse clicks can be used along with the Shift or Ctrl keys as appropriate to assist with making the 
selection. Figure 56 shows four data file rows selected, as indicated by the blue highlighting.

Select all rows in table

Deselect all rows in table

Copy selected rows in table to Clipboard
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When the desired rows have been selected, changes or additions to the process settings may be entered 
at the top of the page in the Process Parameters area. Sections are provided for parameters associated 
with blank experiment scans, molar heat capacity, and baseline. Select the Apply checkbox for any 
section where changes to settings will be made. When all the desired settings have been entered, click 

on the Update table with settings icon .

To ensure that changes to settings are updated in the file table, check to see that all enabling settings 
such as the appropriate Replace, Replace Existing, or Apply boxes are checked.

 Figure 58 Entering changes to process settings.
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After entering new settings into the table, every cell with altered settings will appear with a red 
highlight, as seen in the Blank column in Figure 59. Cells which are altered but not selected will 
appear with a yellow highlight.

 Figure 59 Files ready to process.
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5 The next step is to process the data files. The button for the action Apply table changes to the dataset 
will now be enabled; click the button to process the datasets. 

Each selected data file row will be processed one by one in sequence. For each line, blank data files 
will be subtracted, baselines will be calculated according to the "pre" and "post" ranges, the baselines 
will be subtracted, and thermodynamic variables will then be calculated. The thermodynamic results 
will be filled into the table as seen in Figure 11.

 Figure 60 File processing completed.

If unexpected results arise, this may have been caused by signal noise causing changes in the details of 
the baseline paths. Exit batch processing mode, select the file(s) in question, and view the Integration 
Baseline window. The baseline can be shifted by moving the adjustment handles (the small open 
circles). When the baseline is redrawn, the thermodynamic values will be updated. If any files warrant 
further study, you can proceed to the Modeling tab.
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 Figure 61 Example of a problematic baseline, in this case needing a manual adjustment.

NOTE: All data is fully synchronized between the batch processing and the 
standard modes of using NanoAnalyze. Any change to a data file setting made in 
either mode will also be present in the other mode. You can save the work on the 
full set of files by saving in the .CSC format from the File menu in the 
NanoAnalyze main window.
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ITC Batch Processing Mode
Start by loading several data files into NanoAnalyze. For convenience they can be organized into a
common folder. Click on the blue Data area and right-click the mouse, then select New Folder. The folder
can be renamed if desired. 

Optionally, an Overlay Graph may be created at this point to review the files before processing. Create an
overlay Graph by right-clicking in the blue area in the Overlay group and select New Overlay Graph.
Drag and drop the file folder from the Data group into the area labeled Datasets to Graph / Drop
primary graph items here.

 Figure 62 

Create a new ITC batch by clicking on the icon. This opens a dialog box for selecting which data files are
to be included in the batch.

 Figure 63 Batch Processing > Create New ITC Batch

 Figure 64 ITC Batch Processing Data Selection.
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A new main window for ITC batch processing displays.

 Figure 65 ITC Batch Processing window.

Tool bar item descriptions:

 Figure 66 Toolbar.

 Add and Delete files

 Calculate all files, calculate selected files, stop calculation.

 Sort in ascending order, sort in descending order: The order is determined by the
calculated thermodynamic values, each category multiplied by its assigned weighting value.

 Settings: Launches the Settings dialog box.

The Settings dialog box allows the user to input a weighting function to be used as data sorting criteria.
The default weighting factors are all 1.0. Use a higher weighting factor on a parameter to increase the
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emphasis during the sorting. Use lower factors to decrease the emphasis. Only the relative values of
numbers matter.

 Figure 67 Settings dialog.

 Set Defaults: Sets the current selection of models as the default choice when creating a new ITC
Batch process.

 Experiment Parameters: Launches the Experiment Parameters dialog box.

The Experiment Parameters dialog box provides access to adjusting experiment parameters such as the
sample data and analysis temperature, and applying the changes to all loaded files, or to the selected files
only.

 Figure 68 Experiment Parameters dialog.
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 Integration Window controls: The Auto button
automatically fits baseline nodes and integration windows to the data based on automatic interpretation.
This generally gives the best results. When the signal levels are very low it might become necessary to
manually set the integration windows. Enter a time value in seconds for a different integration window
width, select the files the change is to be applied to, and then click the graphic icon to apply the changes.
Note that the default integration width is the same as the injection interval. Use this control to set a
narrower window for integration. Use this only to exclude regions of stable baseline between injection
peaks. 

 

Injection Blanks controls: 

• Update selection with new values

• Enter a constant to be used for all peaks (option 1)

• Drop a blank file to be used on a point by point basis (option 2)

• Point by Point/Average selection toggle button

The typical method for NanoAnalyze model fitting of ITC data is to include a Blank (Constant) model
along with the binding model in order to automatically calculate blank values for the peaks in which little
to no reactions occur. However this may not be practical if the full titration curve is not realized in the
experiment. As an alternative, blank data can be obtained separately. A constant value can be entered, and
then the graphic icon in this group would apply that blank value to all peaks. Another method is to run a
Blank Experiment with the same timing as the Sample Experiment, then drag and drop the file into the
provided window. In this case there will be an option to apply the blanks on a one-by one basis (peak 1 of
the blanks is subtracted from peak 1 of the sample experiment, etc.), or the average of all the blank peaks
can be used. Click the Point By Point icon to change it to "Average" or vice versa. 

 Export to File, Print All Bar Graphs, Print Select Bar Graphs: The export option
outputs a table of all data into a plain text (.txt) file or a Microsoft Excel compatible file (.xls) for external
processing or report generation.

 Save all or selected images into .jpg files for printing
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Adding files to be processed in a batch
Use the red "+" sign icon to open a dialog box in order to add files into the batch process selection. Make a
multi-selection by using Ctrl-mouse click to add one file at a time, or Shift-click to select a group.

 Figure 69 Add files.

Click Add/Close to complete the selection. The files will display in the batch data table at the bottom of
the window:

 Figure 70 Files displayed in the batch data table.
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Click on the "*" button in the Models area to bring up a dialog box for selecting models. Click OK when
finished.

 Figure 71 Model Selection dialog.

Click on the green arrow icon to start the model fitting. When completed, the thermodynamic data will
display in the data table.

 Figure 72 
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Hovering the mouse cursor over a data parameter column header will display a comparison graph of all
files for that parameter.

 Figure 73 Comparison graph.

Add the fitted data to the Overlay Graph, if desired. Drag and drop the folder into the secondary graph area
and the fitted curves will display.

 Figure 74 Fitted curves displayed.
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Advanced Features
Statistical Analysis of Models
Once a model has been satisfactorily fitted to a set of experimental data the parameters are considered to be
an optimal fit of the chosen model to the experimental data. This is represented with an example of an
isothermal titration experiment, as shown below.

 Figure 75 Isothermal titration experiment.

The Statistics page is used to calculate estimates of the uncertainty of the model parameters. In multiple
trials, a defined amount of variation is introduced into the model and the fitting will be performed again.
Each parameter will vary within a Gaussian distribution, which will be characterized.

The first step is to construct a reference set of “perfect” synthetic data points from the model curve. At the
x-axis location of each experimental data point, the value of the model equation is calculated. These
synthetic data points are idealized and therefore have no scatter, as seen below.

 Figure 76 Idealized data points.
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The next steps are to introduce a series of trials consisting of temporary perturbations to this idealized data
set, re-fit the model for each trial, and record the resulting distributions of each model parameter (with the
exception of the blank, if present). This repetitive process is represented below.

 Figure 77 Multiple trials.

Random noise is superimposed onto the heat value at each of the X-axis data points in the reference set in
a carefully controlled manner. Each change is randomly generated within a Gaussian distribution that has a
standard deviation identical to that of the original data set. This figure is displayed on the Modeling page
between the windows for the Model and the Residuals. Each model parameter will also tend to be
normally distributed, provided that a sufficiently large number of trials have been performed.

Statistics Work Flow:
1 Fit a model (or multiple models) to the data from an experiment. Be sure that the fitting has been opti-

mized, and that all changes to the model have been finalized before moving on to the Statistics page. 
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NanoAnalyze automatically transfers the values of the fit parameters and the standard deviation 
around the fit.

 Figure 78 

2 Proceed to the Statistics page. 

 Figure 79 Statistics.

NOTE: If a Blank model was used in the fit, uncheck the box next to the Blank in 
the Included Models group. Blanks should not be subjected to the random noise 
because this interferes with the ΔH variation, causing an incorrect distribution.
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3 Select the model on which the statistical study is to be performed and an appropriate number of trials 
(typically 100 to 1000) and click Start. The figure for Standard Deviation was carried over 
automatically from the Modeling page and does not need to be entered manually. The Desired 
Confidence Level and number of bars in the histogram can be adjusted either before or after running 
the trials. The trials can be halted with the Stop button; in this case the histogram and confidence levels 
will be adjusted according to any trials that have completed.

 Figure 80 Select number of trials.

4 Select the desired Confidence Level (68.27%, 90%, 95%, or 99%), the number of bars (10 to 50), and 
a parameter from the list in the upper group. The histogram will be displayed in a chart, and the 
confidence level will be displayed in the graph table and also in the table near the top of the window. 
The confidence level % and the number of bars can be changed at any time. The greater the number of 
trials, the closer the distributions of the parameters will be to the expected Gaussian shape.

 Figure 81 Select the Confidence Level.

NOTE: If anything is changed in the Modeling tab, the Statistics information will 
no longer be valid and will be cleared.
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5 The Confidence Intervals are multiples of the standard deviations of the distributions. An interval of 
+/- one standard deviation around the mean is assigned a 68.27% probability. Higher levels of 
confidence are associated with wider confidence intervals. 

The confidence intervals are based on the assumption that the standard deviations of the parameter
distributions have been accurately determined. This is equivalent to an assumption that the observed
distribution closely approximates the Gaussian function. However, this will not be a good assumption for
small numbers of trials. The following figures illustrate examples that resulted from running 50,000 and 30
trials, respectively. Note that there is a significant bias in the case of the 30-trial example.

 Figure 82 Confidence Intervals.

Number of Standard Deviations Confidence Interval

1 68.27%

1.645 90%

1.960 95%

2.576 99%
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 Figure 83 Confidence Intervals.

It is not necessary to produce a perfect-looking distribution. However, the risk of running too few trials is
that the calculated confidence intervals might not accurately reflect the true potential for variation.
Generally, 100 trials will be sufficient for quick investigations, and 1000 will often be sufficient for more
precise work. The figure below illustrates the more consistent results that will be obtained by using a
sufficiently high number of trials. Note that with 10 trials the confidence interval results varied by nearly a
factor of 6; on the other hand there tends to be little practical benefit to using more than 1000. 

 Figure 84 Selecting an appropriate number of trials.
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ITC Experiment Design

Introduction
The Experiment Design module is an exploratory tool for optimizing the conditions of ITC experiments in
order to maximize the quality of the resulting data. Any ITC model can be incorporated into the simulation
and direct controls for all experimental parameters are provided.

An ideal and efficient ITC experiment would generate data from which it will be possible to obtain good
values for n, ΔH, and Ka in only one run. This is possible when the typical S-curve of the titration is fully
revealed according to these criteria:

• The curve displays a full "S" shape.

• There are multiple injection points populating the low-slope pre-inflection region.

• The inflection point is described well with multiple injections occurring in the central nearly linear 
section, with a moderate slope.

• There are multiple injections sampling the low-slope post-saturation section of the curve.

• The integrated enthalpy values were large enough to achieve a good signal to noise ratio, which helps 
insure that the results will repeatable.

The most important decisions to be made before running the titration experiment will be the selections of
the sample concentrations. This requires that values are entered for the thermodynamic constants. There
may be a need to develop the knowledge of the chemical system in steps. Any a priori knowledge of the
chemical system can serve as a starting point, or perhaps an initial experiment may have been run but it
delivered only partial results. The Experiment Design module makes it possible to refine the next
experiment, potentially eliminating multiple trial experiments.

If Ka is high but ΔH is low, there may be mutually exclusive conditions for obtaining good measurements
of both parameters within one experiment. A good measurement of Ka may require reducing the sample
concentrations, however higher concentrations in a separate experiment may be needed to measure ΔH.
Any information learned in either of those experiments can be updated into the model in order to help plan
the other.

Using the Experiment Design Feature
To start the ITC Experiment Design module, select Experiment Design > ITC in the main menu of
NanoAnalyze.

 Figure 85 Starting the Experiment Design module.
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Click on the indicated control to bring up the model selection dialog box. The Independent binding model
will be used for this example. The default settings for the initial default values of the thermodynamic
values will be in place, but these can be manually adjusted as necessary.

 Figure 86 Selecting a Model.

The dialog box is organized into several functional groups as shown in Figure 69, and are described below.

 Figure 87 Controls and experiment simulation display.
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A Sample concentration adjustment controls.

 Figure 88 Sample Concentration Limits dialog box.

• Concentrations can be adjusted using the sliders, the "+" or "-" incrementing buttons, or the 
direct text entry boxes. 

• The upper and lower limits of the sliders can be adjusted in the dialog box that is brought up 
by clicking Limit Concentration Range. Use relatively narrow limits in order to obtain fine 
adjustment increments in a specific region of concentrations.

• When the Lock Syringe to Cell Slider box is checked, both concentrations will be simultane-
ously adjusted (with a constant ratio) when the Cell Concentration slider is moved. The 
syringe concentration can always be independently adjusted via its slider control. This linked 
behavior can be very useful in cases of low ΔH and/or high Ka because it clearly demonstrates 
the trade-off between achieving good enthalpy levels that are well above the instrument noise, 
vs. achieving several points distributed along a moderate slope in the inflection region. If the 
slope at the inflection is extreme then Ka would not be accurately determined; only a lower 
bound would be obtained.

• Changes made to the sample concentrations will be reflected immediately in the graph.

B Thermodynamic variables adjustment controls.

C  ITC instrument injection settings group.

• Change the injection settings or the desired enthalpy units in this control group.

• After making adjustments to any of the injection controls, click Update to show the current 
results in the graph.
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D Whenever the independent model is loaded there will be selection buttons and indicator reading of 
the current value of the calculated parameter C, defined as C = Ka x [Mcell] x n. When the value of 
C is close to 100 the experiment is optimally designed to be able to simultaneously measure n, ΔH 
and Ka, for the reasons outlined at the beginning of this section.

E Experiment Design File controls. Use these to Save or Load experiment designs. 

F The simulated experiment can be copied into the data file tree in the main NanoAnalyze window 
by using the Export to Dataset button.

 Figure 89 Experiment Design data exported to the main NanoAnalyze window.
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G Experiment Simulation graph and the Graph Settings tab. 

 Figure 90 Showing the location of the Export button and the expanded Graph Settings tab.

• The experiment simulation with titration curve and thermodynamic values appears in this sec-
tion.

• The graph appearance can be adjusted via controls that are hidden by default. They can be 
accessed by clicking on the Graph Settings border. To hide the graph settings, click on the 
">>" symbol as highlighted in Figure 72 above.

Independent Model Optimizer
An experiment optimizing feature is available for the Independent binding model. There are many
interacting variables which may require several attempts to optimize when using individual manual
adjustments. Another alternative is to use the optimizer which makes simultaneous adjustments in order to
arrive at a C value of 100. It adjusts the sample concentrations while retaining the current values of the
injection settings. If either sample concentration needs to be adjusted outside of the current settings for the
slider limits, it will set the ideal concentration and expand the adjustment range as necessary. 

There may be external constraints which could make it impractical to use a theoretically ideal optimized
design, for example acid-base titrations performed at low concentrations might risk interference from
atmospheric carbon dioxide. Other C values can be selected using the option buttons as one way to explore
alternative experiment designs.
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Pressure Perturbation Experiments
Colette Quinn, Ph.D. and Lee Hansen, Ph.D.
TA Instruments, 890 West 410 North, Lindon, UT 84042, USA

Introduction
Pressure Perturbation Calorimetry (PPC) is a technique for determination of thermal and volumetric prop-
erties of macromolecules. These properties include the partial molar thermal cubic expansion coefficient 
( , Equation 1, [1]) and the relative partial molar volume ( , Equation 2, [2]) of the macromolecule 
as functions of temperature. These parameters are associated with hydration of the macromolecule [3, 4].  
The method consists of measuring the heat effect, Q, from applying a pressure change, p, to a solution 
of the macromolecule.  and  are then calculated by the following equations.

The Nano DSC is currently equipped with the necessary components to perform PPC without further mod-
ification. PPC is typically performed on a DSC that is capable of increasing and decreasing the pressure on 
a sample during a DSC temperature scan or during isothermal measurements. During a temperature scan, 
the pressure change must occur faster than the heating or cooling of the system (3, 4). This note is a short 
tutorial on the required steps to set-up an experiment on the Nano DSC with DSCRun software and then on 
analysis of the resulting PPC data with NanoAnalyze software to evaluate , which denoted as TEC in the 
software.

PPC with DSCRun
Turn on the Nano DSC, then open DSCRun and allow the system to stabilize. In the DSCRun software 
open set runtime variable under the Tools menu. 

On the Experimental Method tab, check either scanning or isothermal and enter the temperature limits 
and scan rate; see Figure 91. If scanning, a slow rate is required because the calculations assume isothermal 
conditions; see the definition of  in Equation 1 (4). If the scan rate is slower than the instrument feedback 
then it can be safely assumed isothermal during the pressure steps. A rate of 0.1 ºC/min is recommended. 
This scan rate will typically satisfy the isothermal requirement without scanning so slowly that resolution 
of the heat rate is unduly sacrificed.
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Choose the pressure function to be applied during the experiment. See Figure 91.

 Figure 91 Screen shot of DSCRun highlighting the different pressure parameters available.

Three different pressure control options are available: linear, sine, or ramp (labeled jump in the software). 
The jump pressure function is usually used. Once the desired pressure function is selected and all Temper-
ature Parameters are set for the scan, click Add To Experiment Method. This opens a dialog box that 
enables setting the Jump Pressure Function. 

 Figure 92 Screen shot of dialog box that opens after a pressure function has been selected. (A indicates 
atmospheres and s indicates seconds.)
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Note that in scanning experiments, pressure can be designated as a function of time or temperature. The 
term "step" in this box refers to the pressure step. Although the instrument is capable of operating from 0 to 
6 atm, relative to ambient pressure, the recommended pressure change is from 1 to 5 atm with a ramp/step 
time of 600 s (4). The minimum pressure must exceed a pressure that allows boiling at any temperature 
during the scan. For most experiments, the default motor speed of 28 x 10-1 ms/step is sufficiently slow to 
satisfy the requirement of isobaric conditions in Equation 1.

Experimental Set-up
A water-water scan can serve as a test experiment to assess any asymmetry between the reference and sam-
ple cells. For this test, water is loaded into both the reference and sample cell. The pressure is stepped from 
1 to 5 atm, starting at low pressure with time steps of 600 s while scanning at 0.1 ºC/min from 20 to 80 ºC. 
During the experiment pressure is applied equally to both sample and reference cells, so any deviation of 
Q from zero is solely due to any asymmetry between the cells.

For typical solutions of macromolecules, a concentration of 10 mg/mL should generate good data. Due to 
the slow scan rate, concentration requirements for PPC experiments are greater than for a normal DSC 
scan. The PPC experiment consists of two parts, a background run and a sample run. Background data with 
buffer in both reference and sample cells should be collected under identical PPC conditions as the sample. 
Sample data must be collected with the same buffer in the sample cell. The basis for this method and the 
calculations done in NanoAnalyze are as follows (Equations 3-5).

measured is calculated from the data with sample solution in the sample cell and buffer in the reference cell 
and asymmetry is calculated from the data with buffer in both cells.

PPC Fitting with NanoAnalyze
The data files from the background PPC run and the sample PPC run can be opened in NanoAnlayze with-
out modification. When the raw data files are initially opened, a dialogue box will open with a prompt: 
Analyze pressure data for Experiment Step 1? (Figure 93). In this context, "step" indicates a tempera-
ture scan or isothermal run. This request will be made for each temperature scan or isothermal run if the 
box at the bottom is not checked.  

 Figure 93 Dialogue box prompt when opening PPC data with NanoAnalyze.
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When the files are opened, extra data analysis tabs are automatically made accessible (Figure 94). 

 Figure 94 Screen shot highlighting the extra tabs accessible after opening PPC data on NanoAnalyze. 

In the Input Data tab, several key values must be entered for TEC calculations, i.e., sample cell volume, 
concentration, and molecular weight in kilodaltons. The data file is loaded with the Add file icon. The 
background data is dragged and dropped into the drop baseline here box (Figure 94). MHC (molar heat 
capacity), the second tab, is not used in PPC calculations. The third tab from the left, Integration Base-
line, gives the integrated area under each pressure events. The baseline for integration of the heat effects 
(Q) from the pressure changes can be either a straight-line (default) or a sigmoid (check Sigmoid Base-
line box) (Figure 95).  

 Figure 95 PPC sample and background data in the Integration Baseline window.
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In the Area graphs tab (Figure 96), background and sample areas are plotted. The baseline area data can 
be fit to a polynomial, labeled blank fit order in the software (as is the case with TEC Baseline and TEC 
tabs).  

 Figure 96 Area graphs window for a sample. 

The TEC Baseline is used for calculating  for pure liquids, and is not used for calculation of  for sol-
utes.

The TEC tab plots the thermal expansion coefficients in the top window (Figure 7) and the integrated area 
in the bottom window. This integrated area is the relative change in volume ( ), according to the rela-
tionship of Equation 2 (3).

 Figure 97 The TEC ( ) for a sample.

Numerical values for all of the thermal expansion data are displayed in the Table tab and can be copied to 
a clipboard and imported to another program if further manipulation is desired.
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Importing Calorimeter Data into NanoAnalyze From *.txt 
Files
Calorimeter data in the form of text files can be imported into NanoAnalyze for analysis. The Import
function is flexible with regard to character encoding, separator characters, and column layout.

1 In the File menu, select Import Text File.

 Figure 98 File > Import Test File.

2 Navigate to the folder containing the desired file and select it.

3 Several customizing settings are available to accommodate various options of the format of the text 
file:

• The Encoding selection by default will follow the currently used Regional settings in MS Win-
dows. Other types can be selected if necessary. 

• If the text contains more than one column you will need to select the appropriate Delimiter. There 
is typically a space or other character to separate one data field from the next. Each logical data 
record such as the data from one point in time, or associated with one integration must appear on 
its own line. Each line may contain more than one data type, for example a time stamp, a heat rate, 
an injection quantity, etc. 

• The Analysis Type must be selected according to the type of experiment.
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• Each Analysis Type has options for the categories of data that may be present. 

 Figure 99 Import text options.

In the following example, integrations from an Isothermal Titration Calorimeter are being imported. In this
case there is only one column so the Delimiter is not required. ITC Areas was selected. The data to be
imported are heat rates, therefore the Analysis Column Name should be selected as Q (µJ). Note that this
is a Required field for this data type. If Injection Volume or Cell Volume data are present they may also be
imported at this time.

Each column to be imported must have a name assigned. Select the appropriate line from the Analysis
Column Name, and drag and drop it onto the column in the data table at the lower left of the dialog box.
The text column is highlighted in blue when this has been completed.

If the file contains a header above the data table or any trailing text below the table, adjust the row numbers
as appropriate in the fields for Start data import at row and Stop data import at row. If comments are
present in the file they may also be imported; use the start and stop line controls as needed to define what
should be imported.
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When all data to be imported has been assigned (and if necessary, limited), click Import 

 Figure 100 

The data will be imported into the appropriate page in NanoAnalyze according to what type of information
is represented. Raw data would go into the Data tab. In this case ITC integration areas were imported into
the Analysis/Area tab.
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Note that some data fields required for Modeling might not be present but they must be filled in before
proceeding. Yellow highlights indicated which fields need attention.

 Figure 101 Yellow highlighting indicates fields that need to be filled.

When all required fields have been completed, Modeling may proceed as already described in this Guide.
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Overlay Graphs
The Baseline tab also serves as an output graph formatter using the Overlay Graphs feature. Multiple data
series graphs can be superimposed if desired, and publication quality charts can be formatted with a wide
variety of formatting options.

1 Load a data file and go to the Analysis tab (from the left side group) and the Baseline tab (from the top 
group).

 Figure 102 Load a data file.

2 Start an Overlay Graph in one of the following three ways: via File > New Overlay Graph, Ctrl+P, or 
by right-clicking the mouse in the Overlay Graph area at the lower left of the NanoAnalyze window.

 Figure 103 Creating a new Overlay Graph
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Creating Publication-Quality Graphs
Drag a data file into the Primary Graph area to the right of the data file tree.

 Figure 104 Create the Primary Graph.

A secondary graph can also be created by dragging a data file into the Secondary area. This can be the
same data file as the Primary, and can be used to graph a different quantity.

 Figure 105 Create a Secondary Graph.
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The Secondary graph can be separated into its own chart by using the Split Graph check box in the Graph
Style control group, found at the right side of the window.

 Figure 106 Split Graphs.

The controls for graph formatting are grouped into four tabs at the right side of the window. 
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The Axes tab provides independent controls for each chart, with multiple options in drop-down menus.
The Graph Style tab contains check boxes to selectively show various chart features. The Manual Zoom
tab applies the axis limits when the Manual Zoom checkbox is enabled. The Font Settings tab provides a
global font size control along with separate controls for individual text objects.

 Figure 107 Graph formatting tabs.

Exporting Publication-Quality Graphs
The tool bar at the top of NanoAnalyze contains controls to allow exporting graphs in a variety of formats
to either the file system or into the Windows clipboard for pasting into other applications. The export
format options include the two scalable image formats EMF and WMF. There are also fixed-resolution
raster output formats BMP, JPG, and PNG. Generally the highest quality images are available in the EMF
and WMF formats.

 Figure 108 Export Controls.
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1 Click on either Export to Clipboard… or Export to File… and select the desired image format. If 
you choose to create a file you will be asked to enter the file name and select a folder location.

 Figure 109 Selecting image export format.

2 A dialog box displays a representation of the graph. The aspect ratio, or ratio of length to height of the 
image, can be selected. Click Export to complete the graph export.

 Figure 110  Image Export Settings.
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Creating Graphs with Multiple Data Files
Load multiple files that you wish to compare into the file tree, and create a new Overlay Graph. Populate
the graph by dragging files from the file tree over into the Primary graph data area.

 Figure 111  Populating multiple files into an Overlay Graph.
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The data traces from each experiment will be graphed together. The files may be manually moved within
the graph window to create a separation for visual emphasis. Note the DSC scans cannot be moved
horizontally along a Temperature axis. In the Graph Style tab, select or deselect Lock X-Axis or Y-Axis as
appropriate. Click on a data trace and drag to the desired position. Handles will appear on the selected data
trace.

 Figure 112  Selected data trace.
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Exporting Data
It is frequently necessary to export instrument raw or processed data to external software applications such
as word processors or spreadsheets. Data export functions have been provided in most locations within TA
Instruments’ software applications. 

Data Export from a Table
Where data appears in a table (for example, in the NanoAnalyze Data viewing tab for a Nano ITC
experiment or a Nano DSC scan), place the mouse cursor over the data table and right-click the mouse. A
small pop-up menu appears.

 Figure 113  Copy All Cells.

Move the cursor onto and then release the button over the item labeled Copy All Cells. An hourglass icon
may appear briefly while the data table is copied to the Windows clipboard. When the cursor returns to the
normal arrow, the clipboard will contain a copy of the complete table for the entire experiment or scan. In
the receiving application, use the mouse to select the desired location to paste the data. The application’s
Paste or Paste Special function (or the Control-V keyboard combination) will then create a copy of the
data in the receiving application.
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Copy to Clipboard Function
Some pages support data export via a dedicated control such as the Copy to Clipboard button seen in the
Area tab of NanoAnalyze. The data is copied into the Windows clipboard when this button is clicked, and
is ready to paste into a receiving application.

 Figure 114  Area tab > Copy To Clipboard.
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Export Dialog Function
Pages that display graphs have an export function that is accessed via a pop-up menu within the chart area. 

1 Right-click the mouse inside the chart and select the Export Dialog item on the menu:

 Figure 115  Export Dialog...

2 Select the Text > Data Only option and click the Export button. (Another available feature is to 
export an image of the graph using the Metafile, BMP, JPG, or PNG formats.)

 Figure 116  Select Text/Data Only.
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3 For a more compact table of numeric results, select Data in the Export What group. The List option 
in the Export Style group creates a vertical array of data (narrow and long), while the Table option 
creates a horizontal array (wide and short). In general it is best to use the Maximum Precision option.

 Figure 117  Export... dialog box.

When the data is copied to the clipboard, the dialog box closes.
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Display Format Options
The visual appearance of TA Instruments software applications can be altered via functions available in a
pop-up menu. Right-click the mouse while inside any window or tab to bring up the menu. There are
appearance options for the screen area, plotting style, font, and number formats. Many of these options can
be directly accessed from this menu.

 Figure 118  Formatting appearance.
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A more complete set of display options can be accessed through the Customization Dialog menu item.
Right-click on the data graph to bring up the menu:

 Figure 119  Select Customization Dialog...
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The display controls have been grouped into tabs for easy access.

 Figure 120  Customization... dialog box.
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Appendix: A
NanoAnalyze Reports

Creating the Report
After a data file has been analyzed a customized report can be created. 

1 Select the Reports tab at the top of the software window.

 Figure 121 

2 Select to Create Report (Default Template), Create Blank Report, or Create Report Using Template 
File. Click Ok 
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 Figure 122 

The report file opens based on the selection above. In this example, and empty Reports page displays.   

 Figure 123 

Report Tab
The following functions are available in the Report tab:     

 Figure 124 

The Document Tokens area contains controls for adding selected portions of the available experiment 
information. A report object can be added by double-clicking the desired item. In this case, the Experi-
ment Data group was expanded, then the Experiment Information group was expanded, and then 
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Experiment Information was double-clicked, bringing a table of the contained items over into the Report 
page on the left:  

 Figure 125 

Additional text can be added by clicking at the desired point in the Report and then typing in the content. 

 Figure 126 

Notice that there was no name or date entered on the example text above. Another feature of the Document 
Tokens is that sub-items can be inserted as text objects at any point on the report. In the example below the 
test cursor was first set at the desired insertion point (between the quote marks that had been entered in the 
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type-in text appearing above), and then the token for the appropriate data object was then double-clicked. 
This brings the token over to the selected location as new text:    

 Figure 127 

If it is desired to remove any content, select it and press the Delete key on the keyboard. Any objects of 
text can be selected in any of the typical methods for Windows software, such as a single click, a click-and-
drag, or click at the start point and then Shift-click at the end point of a section to be deleted.

Continue until the report has been formatted in the desired way. This format can be saved as a Template 
which can be selected in subsequent work. Another option is to save it as the Default Template, which 
would then be automatically selected when creating a new report from another experiment.   

 Figure 128 
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Paper copies of the report may be printed from the Document menu. The Print dialog also gives an option 
to create an Adobe PDF format file from the report:  

 Figure 129 
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Appendix: B
Processing of Enzyme Kinetics Experiments

NanoAnalyze can process enzyme kinetics experiments using either the Michaelis-Menten or the 
Lineweaver-Burk methods. To get started, load a kinetics experiment data file into NanoAnalyze. An addi-
tional data file from an experiment based on the same chemical system, but with the concentrations 
adjusted in order to provide simple enthalpy data, can optionally be loaded as well.

 Figure 130 

Now the data must be converted into the MIM format. In the File tree on the left side of the NanoAnalyze 
window right-click the file and select Properties.

 Figure 131 
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Select "Convert to MIM Enzyme Kinetics" and then click "Ok".

 Figure 132 

NanoAnalyze is now in the enzyme kinetics analysis mode. New controls and tabs for the processing steps 
appear above the data window. The concentration values, if they were input in ITCRun software at the time 
of setting up the experiment, will be carried over into NanoAnalyze. If desired, the units of concentration 
can be changed in NanoAnalyze software using the drop-down menu at the upper left of this page.

 Figure 133 
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This zoomed-in view of the first several injections shows that analysis windows for each injection interval 
have been defined at the default range of the final 20% of each injection interval window.

 Figure 134 

The widths may be adjusted if necessary, by altering the starting times for the windows. The start time can 
be altered by either entering a percentage figure in the text entry box (click the blue arrow icon to accept 
the updated number), moving the slider control, or clicking on the "-" or "+" buttons. The ends of the active 
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data windows are always located at the ends of their injection intervals; only the starting times are 
adjusted.

 Figure 135 

Proceed to the Enthalpy tab. The next step is to enter an enthalpy value for the reaction. 

The value can be entered manually if this value is already known. Type the value into the entry window 
and click the "Apply" button. The manual entry box is highlighted in red.

 Figure 136 

Another method of entering the enthalpy value is to extract it directly from an enthalpy experiment file. An 
enthalpy-only enzyme experiment typically uses a reduced injection amount to allow the reactions for each 
injection to proceed to completion within a short time interval. In the example shown below the substrate 
concentration was reduced by a factor of 25 in comparison to the kinetics experiment. The interval needs to 
be long enough to insure that the signal returns to baseline. For the enthalpy only titration, the substrate 
concentration is decreased and the enzyme concentration is increase. Under these conditions of low sub-
strate and high enzyme, the enzyme will convert all of the substrate into product.
Page 93 of 114



Add an enthalpy experiment into NanoAnalyze and it will appear in the file tree at the left of the program 
window. Click and drag the file over to the box titled "Drop Data Here". These fields are highlighted in 
green in the prior Figure 136. An average enthalpy value is calculated from all integrated peaks. This 
example exhibits the typical condition of initial peaks that have reduced areas due to the loss of some reac-
tant from the injection syringe that occurs during the thermal stabilization of the samples in the instrument. 
The initial peak needs to be discarded in order to allow a correct averaging of the remaining peaks.

 Figure 137 

Individual peaks can be deselected by clicking on the appropriate green dot in the lower graph. Deselected 
dots show as gray instead of green. The average is now calculated on the basis of the remaining injection 
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peaks, and is now a visibly better representation of the correct average. The value in the calculated 
enthalpy window is automatically updated.

 Figure 138 

The kinetics calculations are now completed and ready for review. Michaelis-Menten and Lineweaver-
Burk analysis methods are presented. Individual data points that might not fit the modeling function, most 
likely the early injection peaks, can be deselected by clicking on the colored dots. Both analysis methods 
are updated, and the deselected data points turn gray. There may be a difference between the calculated 
results of the two methods because of the nonlinear scale transformation, which effectively changes the 
weighting values of the data points. In the Michaelis-Menten method the weighting is equal for all data 
points. In the example shown below the data points for the first three injections have been eliminated in 
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order to allow for an improved fit of the modeling curve. Note that when the view is switched to the 
Lineweaver-Burk analysis method, the same points are deselected there was well.

 Figure 139 

The Lineweaver-Burk method features a stronger weighting of the data points from the later injections, 
which appear on the right hand side of the chart. Note that any data points which have been eliminated in 
the Michaelis-Menten analysis tab are also eliminated from the data set used for the Lineweaver-Burk 
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analysis. Note that because Michaelis-Menten and Lineweaver-Burk have different weightings of the data 
points in their curve fits, it is possible for the analytical results to differ as well.

 Figure 140 

The numeric formats of the data fields in the results table can be adjusted if necessary. Click the Settings 

icon  to bring up a dialog box for setting the desired numeric formats.
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Select the desired number of display digits for any date field and click the "Ok" button when done.

 Figure 141 
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Appendix: C
Models Reference

ITC Binding Model Name: Independent

Main Function
' quadratic constants a, b, and c

Dim a As Double =  Ka

Dim b As Double = -Ka * (MolesSyringe(iteration) + MolesCell(iteration) * n) - CellVolume(iteration) / 
1e6

Dim c As Double =  Ka * MolesSyringe(iteration) * MolesCell(iteration) * n

Bound = (-b - Sqrt(b*b - 4*a*c)) / (2*a)' Calculate the root using quadratic formula

If OverfillMode Then' Take loss of solution from overfill into account

    OldBound = OldBound * (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

End If

Heat = 1e9 * (Bound-Oldbound) * dh' Calculate heat

Oldbound = Bound' Save value of bound for the next iteration of modeldatapoint()

Return Heat

Initialization Functions
OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)

OldBound = 0

Auxiliary Functions
Public Function dS() As Double

   Return (dH * 1000 + R * (Temperature + 273.15) * log(Ka)) / (Temperature + 273.15)

End Function

Public Function Kd() As Double

   Return 1 / Ka

End Function
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Global Variables and Constants
 Dim OldBound As Double

 Dim OverfillMode As Boolean

 Dim Bound As Double

 Dim TotalCellVolume As Double

 Dim Heat As Double

Provided Constants
These constants are automatically created and are available for use in the model.

 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621

ITC Binding Model Name: Cooperative

Main Function
CellVol = CellVolume(iteration) / 1e6

St = (MolesSyringe(iteration) / CellVol)

Ct = (MolesCell(iteration) / CellVol)

XFree = Host.ZBrentRootFinder(0, St, 1e-12, 1000, AddressOf Equation, St, Ct, B1, B2)

Summation = (B1 * XFree * dH1 + B2 * XFree * XFree * dH2) * 1000

      Z = Host.ZBrentPartition(XFree, B1, B2)

 Q = 1e6 * Summation * CellVol * Ct / Z

If OverfillMode Then

PrevQ = PrevQ * (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

End If

dQ = Q - PrevQ

PrevQ = Q

Return dQ
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Initialization Function
OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)

PrevQ = 0

Auxiliary Functions
Private Function Equation(ByVal x As Double, ParamArray params() As Double) As Double

    Dim St As Double = params(0)

Dim Ct As Double = params(1)

Dim B1 As Double = params(2)

Dim B2 As Double = params(3)

Dim z As Double = B1 * x + B2 * 2 * x * x

Return St - x - Ct * z / Host.Partition(x, B1, B2)

End Function

Global Variables and Constants
Dim CellVol

Dim St

Dim Ct

Dim gB1

Dim gB2

Dim XFree

Dim Z ' Partition

Dim Summation

Dim Q, dQ

Dim PrevQ

Dim OverfillMode

Dim TotalCellVolume

Provided Constants' 
Private Readonly TitrantmM as Double = 0.1

Private Readonly TitratemM as Double = 1

Private Readonly InitTitrateVol as Double = 950

Private Readonly DefaultInjVol as Double = 5

Private Readonly Temperature as Double = 25
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Private Readonly UsingMicroCalorieUnits as Boolean = False

Private Readonly R as Double = 8.3144621

ITC Model Name: Blank (constant)

Main Function
Return blank

Initialization Functions
 (none)

Auxiliary Functions
 (none)

Global Variables and Constants
 (none)

Provided Constants
 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621

ITC Model Name: Blank (linear)

Main Function
Dim XValue As Double = iteration + 1

Return slope * XValue + intercept

Initialization Functions
 (none)
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Auxiliary Functions
 (none)

Global Variables and Constants
 (none)

Provided Constants
 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621

ITC Binding Model Name: Multiple Sites

Main Function
cellVol = CellVolume(iteration) / 1e6

St = MolesSyringe(iteration) / cellVol

Ct = MolesCell(iteration) / cellVol

 ' Cubic polynomial constants

Dim a As Double = Ka1 * Ka2

Dim b As Double = Ka1 + Ka2 + a * (Ct * (n1 + n2) - St)

Dim c As Double = 1.0 + Ct * (n1 * Ka1 + n2 * Ka2) - St * (Ka1 + Ka2)

Dim d As Double = -St

Dim roots As Double() = Host.GetCubicEquationRoots(a, b, c, d)

Xfree = roots(0)

If OverfillMode Then

     OverfillDisplacementRatio = (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

     OldQ = OldQ * OverfillDisplacementRatio

End If

 Dim Q As Double = 1e9 * cellVol * Ct * (n1 * dH1 * Ka1 * Xfree / (1.0 + Ka1 * Xfree) + n2 * dH2 * Ka2 
* Xfree / (1.0 + Ka2 * Xfree))

Dim dQ As Double = Q - OldQ
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OldQ = Q

Return dQ

Initialization Functions
OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)

OldQ = 0.0

Auxiliary Functions
Public Function dS1() As Double

   Return (dH1 * 1000 + R * (Temperature + 273.15) * log(Ka1)) / (Temperature + 273.15)

End Function

 Public Function dS2() As Double

   Return (dH2 * 1000 + R * (Temperature + 273.15) * log(Ka2)) / (Temperature + 273.15)

 End Function

 Public Function Kd1() As Double

   Return 1 / Ka1

 End Function

 Public Function Kd2() As Double

   Return 1 / Ka2

 End Function

Global Variables and Constants
Dim OldQ

Dim cellVol

Dim St

Dim Ct

Dim Xfree

Dim OverfillMode

Dim OverfillDisplacementRatio

Dim TotalCellVolume
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Provided Constants
 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621

ITC Binding Model Name: Dimer Dissociation

Main Function
CellVol = CellVolume(iteration)/1e6

InjVol = InjectionVolume(iteration)/1e6

Ci = MolesSyringe(iteration) / CellVol

'Calculate total dimer for cell

A = 4.0

B = -4.0 * Ci - Kd

C = Ci * Ci

DimerCell = (-B - Math.Sqrt(B*B -4*A*C)) / (2*A)

If OverfillMode Then

       LastDimerCell = LastDimerCell * (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

End If

Dim Heat As Double = 1e9 * dH *  ( (DimerSyr * InjVol) - ((DimerCell - LastDimerCell) * CellVol) )

LastDimerCell = DimerCell

Return Heat

Initialization Functions
LastDimerCell = 0

OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)
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'calculate total dimer for syringe

Csyr = TitrantmM / 1e3

A = 4

B = -4.0 * Csyr - Kd

C = Csyr * Csyr

DimerSyr = (-B -Math.Sqrt(B*B - 4*A*C)) / (2*A)

Auxiliary Functions
Public Function dS() As Double

  Return (dH * 1000 + R * (Temperature + 273.15) * log(1.0 / Kd)) / (Temperature + 273.15)

End Function

Public Function Ka() As Double

  Return 1.0 / Kd

End Function

Global Variables and Constants
Dim CellVol As Double

Dim InjVol As Double

Dim Csyr As Double

Dim Ci As Double

Dim A As Double

Dim B As Double

Dim C As Double

Dim DimerSyr As Double

Dim DimerCell  As Double

Dim Dimer As Double

Dim LastDimerCell As Double

Dim OldDimer As Double

Dim OverfillMode As Boolean

Dim TotalCellVolume As Double

Provided Constants
Private Readonly TitrantmM as Double = 0.1
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Private Readonly TitratemM as Double = 1

Private Readonly InitTitrateVol as Double = 950

Private Readonly DefaultInjVol as Double = 5

Private Readonly Temperature as Double = 25

Private Readonly UsingMicroCalorieUnits as Boolean = False

Private Readonly R as Double = 8.3144621

ITC Binding Model Name: Competitive Replacement

Main Function
totalL2 = MolesSyringe(iteration) / V

totalP = MolesCell(iteration) / V

totalL1 = totalP * (L1mM / TitratemM)

' Displacement calculation (Experiment must be run in "overfill" mode.)

OverfillDisplacementRatio = (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

LastPL1 = LastPL1 * OverfillDisplacementRatio

LastPL2 = LastPL2 * OverfillDisplacementRatio

PL1 = Host.Minimize(PL1_Estimate, 1.7e-308, max, 2, AddressOf PL1Minimization, Ka1, Ka2, totalP, 
totalL1, totalL2)

PL2 = (totalP - (PL1/((totalL1-PL1)*Ka1)) - PL1)

max = PL1 ' PL1 decreases with each injection

PL1_Estimate = PL1 ' Next estimate

Dim Heat As Double

If iteration = 0 Then

     Heat = 0.0

Else

    Heat = (((PL1-LastPL1) * dH1)+((PL2-LastPL2) * dH2)) * V * 1e9

End If

LastPL1 = PL1

LastPL2 = PL2

Return Heat

Initialization Functions
TotalCellVolume = CellVolume(0)
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LastPL1 = 0

LastPL2 = 0

V = CellVolume(0) / 1000000.0

totalP = MolesCell(0) / V

max = totalP

PL1_Estimate = GetPL1Estimate(1.7e-308, max, Ka1, Ka2, totalP, totalP * (L1mM / TitratemM),       
MolesSyringe(0) / V)

Auxiliary Functions
Public Function dS1() As Double

  Return (dH1 * 1000 + R * (Temperature + 273.15) * log(Ka1)) / (Temperature + 273.15)

End Function

Public Function dS2() As Double

  Return (dH2 * 1000 + R * (Temperature + 273.15) * log(Ka2)) / (Temperature + 273.15)

End Function

Public Function Kd1() As Double

  Return 1 / Ka1

End Function

Public Function Kd2() As Double

  Return 1 / Ka2

End Function

Public Function PL1Minimization(ByVal parameters() As Double) As Double

  Dim PL1 As Double = parameters(0) ' The first parameter is the independent variable

  Dim Ka1 As Double = parameters(1)

  Dim Ka2 As Double = parameters(2)

  Dim totalP As Double = parameters(3)

  Dim totalL1 As Double = parameters(4)

  Dim totalL2 As Double = parameters(5)

  Dim EquationLeftSide As Double

  Dim EquationRightSide As Double

  EquationLeftSide = Ka1 * ((totalP - (PL1 / ((totalL1-PL1) * Ka1)) - PL1) * (totalL1-PL1))
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  EquationRightSide = Ka2 * (totalL2 - (totalP - (PL1 / ((totalL1-PL1) * Ka1)) - PL1)) * PL1

  Return EquationLeftSide - EquationRightSide

End Function

Private Function GetPL1Estimate(ByVal min As Double, ByVal max As Double, ByVal Ka1 As Double, 
ByVal Ka2 As Double,  ByVal totalP As Double, ByVal totalL1 As Double, ByVal totalL2 As Double) As 
Double

  Dim EquationLeftSide As Double

  Dim EquationRightSide As Double

  Dim MinDifference As Double = Double.MaxValue

  Dim Difference As Double

  Dim PL1 As Double

  Dim i As Integer

  Dim MinDifferenceIndex As Integer

  For i = 0 To 100

    PL1 = min + i * (max - min)  / 100.0

    EquationLeftSide = Ka1 * ((totalP - (PL1 / ((totalL1-PL1) * Ka1)) - PL1) * (totalL1-PL1))

    EquationRightSide = Ka2 * (totalL2 - (totalP - (PL1 / ((totalL1-PL1) * Ka1)) - PL1)) * PL1

    Difference = Math.Abs(EquationLeftSide - EquationRightSide)

    If (Difference < MinDifference)  Then

       MinDifference = Difference

       MinDifferenceIndex = i

    End If

  Next i

  Return min + MinDifferenceIndex * (max - min)  / 100.0

End Function

Global Variables and Constants
 Dim PL1 As Double

 Dim PL2 As Double

 Dim LastPL1 As Double

 Dim LastPL2 As Double

 Dim PL1_Estimate As Double

 Dim totalL1 As Double

 Dim totalL2 As Double

 Dim totalP As Double
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 Dim max As Double

 Dim V As Double

 Dim TotalCellVolume As Double

 Dim OverfillDisplacementRatio As Double

Provided Constants
 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621

ITC Binding Model Name: Cooperative

Main Function
  Dim xf

  Dim z

  gB1 = b1

  gB2 = b2

  CellVol = CellVolume(iteration) / 1e6

  St = (MolesSyringe(iteration) / CellVol)

  Ct = (MolesCell(iteration) / CellVol)

  xf = Host.ZBrent(0, St, 1e-12, gB1, gB2, St, Ct)

  z = (b1 * xf * dH1 + b2 * xf * xf * dH2) * 1000

  heat = 1e6 * z * CellVol * Ct / Host.ZBrentPartition(xf, gB1, gB2)

  If OverfillMode Then

     b = b + heat * (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

  End If

  heat = heat + b

  Dim deltaHeat As Double = heat - heatOld

  heatOld = heat

  Return deltaHeat
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Initialization Functions
  OverfillMode = (CellVolume(1) = CellVolume(0))

  TotalCellVolume = CellVolume(0)

  heatOld = 0

  b = 0

Auxiliary Functions
(none)

Global Variables and Constants
  Dim CellVol

  Dim St

  Dim Ct

  Dim gB1

  Dim gB2

  Dim heat

  Dim heatOld

  Dim b

  Dim OverfillMode

  Dim TotalCellVolume

Provided Constants
 Private Readonly TitrantmM as Double = 0.1

 Private Readonly TitratemM as Double = 1

 Private Readonly InitTitrateVol as Double = 950

 Private Readonly DefaultInjVol as Double = 5

 Private Readonly Temperature as Double = 25

 Private Readonly UsingMicroCalorieUnits as Boolean = False

 Private Readonly R as Double = 8.3144621
Page 111 of 128



ITC Binding Model Name: Enthalpy Screening
Main Function
Return Qmean()

Initialization Function
count = CorrectedQ.Length

GetInjectedMoles()

CalcStats()

CalcChemistry()

Auxiliary Functions
Public Function Qmean() As Double

Return _Qmean

End Function

Public Function QStdDev() As Double

Return _QStdDev

End Function

Public Function dH() As Double

Return _dH

End Function

Public Function dG() As Double

Return _dG

End Function

Public Function minusTdS() As Double

Return _minusTDeltaS

End Function

Public Function dHse() As Double

Return _dHse
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End Function

Private Sub CalcStats()

Dim index As Integer

Dim sum As Double = 0

 Dim actualCount As Integer = 0

 ' Calculate mean

For index = 0 To count - 1

If Not (Host.IsPointExcluded(index)) Then

   sum = sum + CorrectedQ(index)

 actualCount = actualCount + 1

End If

Next index

If (actualCount = 0) Then

_Qmean = 0.0

_QStdDev = 0.0

Exit Sub

 Else

_Qmean = sum / actualCount

 End If

 ' Calculate Standard Deviation

sum = 0

For index = 0 To count - 1

If Not (Host.IsPointExcluded(index)) Then

sum = sum + (CorrectedQ(index) - Qmean) * (CorrectedQ(index) - Qmean)

actualCount = actualCount + 1

End If

Next index

_QStdDev = Math.Sqrt(sum / count)
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End Sub

Private Sub CalcChemistry()

 Dim index As Integer

 Dim sum As Double = 0

 Dim actualCount As Integer = 0

 ' Calculate dH

 For index = 0 To count - 1

If Not (Host.IsPointExcluded(index)) Then

   sum = sum + CorrectedQ(index) / (InjectedMoles(index) * 1e9) ' Convert to kJ/mol

actualCount = actualCount + 1

End If

 Next index

 If (actualCount = 0) Then

_dH = 0.0

_dG = 0.0

_minusTDeltaS = 0.0

_dHse = 0.0

Exit Sub

 Else

_dH = sum / actualCount

 End If

 _dG = -R * (Temperature + 273.15) * Math.Log(1 / (Kd * 1e-6)) / 1000

 _minusTDeltaS = _dG - _dH

 ' Calculate Standard Error for dH

 sum = 0

 For index = 0 To count - 1

If Not (Host.IsPointExcluded(index)) Then

Dim Peak_dH As Double = CorrectedQ(index) / (InjectedMoles(index) * 1e9)

   sum = sum + (Peak_dH - _dH) * (Peak_dH - _dH)
Page 114 of 128



 actualCount = actualCount + 1

End If

 Next index

 Dim dH_StdDev As Double = Math.Sqrt(sum / count)

 _dHse = dH_StdDev / Math.Sqrt(count)

End Sub

Private Sub GetInjectedMoles()

Dim index As Integer

ReDim InjectedMoles(count)

For index = count - 1 To 0 Step -1

InjectedMoles(index) = InjectionVolume(index) * TitrantmM * 1e-9

Next index

End Sub

Global Variables and Constants
Dim count As Integer

Dim _Qmean, _QStdDev As Double

Dim _dH, _dHse, _dG, _minusTDeltaS As Double

Dim InjectedMoles() As Double

Provided Constants
Private Readonly TitrantmM as Double = 0.1

Private Readonly TitratemM as Double = 1

Private Readonly InitTitrateVol as Double = 950

Private Readonly DefaultInjVol as Double = 5

Private Readonly Temperature as Double = 25

Private Readonly UsingMicroCalorieUnits as Boolean = False

Private Readonly R as Double = 8.3144621
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ITC Binding Model Name: Sequential Three Site
Main Function
cellVol = CellVolume(iteration) / 1e6

St = (MolesSyringe(iteration) / CellVol)

 Ct = MolesCell(iteration) / cellVol

_Ka1 = 1 / Kd1

_Ka2 = 1 / Kd2

_Ka3 = 1 / Kd3

Dim B1 As Double = _Ka1

Dim B2 As Double = _Ka1 * _Ka2

Dim B3 As Double = _Ka1 * _Ka2 * _Ka3

If OverfillMode Then

' Take loss of solution from overfill into account

Dim OverfillFactor = (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

    PreviousQ = PreviousQ * OverfillFactor

PreviousXFree = PreviousXFree * OverfillFactor

  End If

' Calculate the root using ZBrentalgorithm

  XFree = Host.ZBrentRootFinder(PreviousXFree, St, 1e-16, 1000, AddressOf Equation, St, Ct, B1, 
B2, B3)

Dim P As Double = Host.Partition(XFree, B1, B2, B3)

Dim F1 As Double = B1 * XFree / P

Dim F2 As Double = B2 * XFree * XFree / P

Dim F3 As Double = B3 * XFree * XFree * XFree / P

' Calculate heat

  Q = 1e9 * cellVol * Ct * (F1 * dH1 + F2 * (dH1 + dH2) + F3 * (dH1 + dH2 + dH3))

dQ = Q - PreviousQ

' Save value of heat for the next iteration
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 PreviousQ = Q

PreviousXFree = XFree

Return dQ

Initialization Function
OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)

PreviousQ = 0

PreviousXFree = 0

Auxiliary Functions
Public Function Ka1() As Double

Return 1 / Kd1

End Function

Public Function Ka2() As Double

  Return 1 / Kd2

End Function

Public Function Ka3() As Double

Return 1 / Kd3

End Function

Public Function dS1() As Double

     Return (dH1 * 1000 + R * (Temperature + 273.15) * log(1/Kd1)) / (Temperature + 273.15)

End Function

Public Function dS2() As Double

    Return (dH2 * 1000 + R * (Temperature + 273.15) * log(1/Kd2)) / (Temperature + 273.15)

End Function

Public Function dS3() As Double

    Return (dH3 * 1000 + R * (Temperature + 273.15) * log(1/Kd3)) / (Temperature + 273.15)
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End Function

Private Function Equation(ByVal x As Double, ParamArray params() As Double) As Double

Dim St As Double = params(0)

    Dim Ct As Double = params(1)

    Dim B1 As Double = params(2)

    Dim B2 As Double = params(3)

    Dim B3 As Double = params(4)

    Dim SumOf_iFi As Double = B1 * x + B2 * 2 * x * x + B3 * 3 * x * x * x

    Dim DegreeOfSaturation = SumOf_iFi / Host.Partition(x, B1, B2, B3)

    Return St - x - Ct * DegreeOfSaturation

End Function

Global Variables and Constants
Dim cellVol As Double

Dim St, Ct As Double

Dim Q, dQ, PreviousQ As Double

Dim XFree, PreviousXFree As Double

Dim TotalCellVolume As Double

Dim _Ka1, _Ka2, _Ka3 As Double

Dim OverfillMode As Boolean

Provided Constants
Private Readonly TitrantmM as Double = 0.1

Private Readonly TitratemM as Double = 1

Private Readonly InitTitrateVol as Double = 950

Private Readonly DefaultInjVol as Double = 5

Private Readonly Temperature as Double = 25

Private Readonly UsingMicroCalorieUnits as Boolean = False

Private Readonly R as Double = 8.3144621
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ITC Binding Model Name: Sequential Two Site
Main Function
cellVol = CellVolume(iteration) / 1e6

St = (MolesSyringe(iteration) / CellVol)

 Ct = MolesCell(iteration) / cellVol

_Ka1 = 1 / Kd1

_Ka2 = 1 / Kd2

Dim B1 As Double = _Ka1

Dim B2 As Double = _Ka1 * _Ka2

If OverfillMode Then

' Take loss of solution from overfill into account

Dim OverfillFactor = (TotalCellVolume - InjectionVolume(iteration)) / TotalCellVolume

    PreviousQ = PreviousQ * OverfillFactor

PreviousXFree = PreviousXFree * OverfillFactor

  End If

' Calculate the root using ZBrentalgorithm

  XFree = Host.ZBrentRootFinder(PreviousXFree, St, 1e-16, 1000, AddressOf Equation, St, Ct, B1, 
B2)

Dim P As Double = Host.Partition(XFree, B1, B2)

Dim F1 As Double = B1 * XFree / P

Dim F2 As Double = B2 * XFree * XFree / P

' Calculate heat

  Q = 1e9 * cellVol * Ct * (F1 * dH1 + F2 * (dH1 + dH2))

dQ = Q - PreviousQ

' Save value of heat for the next iteration

 PreviousQ = Q

PreviousXFree = XFree
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  Return dQ

Initialization Function
OverfillMode = (CellVolume(1) = CellVolume(0))

TotalCellVolume = CellVolume(0)

PreviousQ = 0

PreviousXFree = 0

Auxiliary Functions
Public Function Ka1() As Double

Return 1 / Kd1

End Function

Public Function Ka2() As Double

Return 1 / Kd2

End Function

Public Function dS1() As Double

    Return (dH1 * 1000 + R * (Temperature + 273.15) * log(1/Kd1)) / (Temperature + 273.15)

End Function

Public Function dS2() As Double

    Return (dH2 * 1000 + R * (Temperature + 273.15) * log(1/Kd2)) / (Temperature + 273.15)

End Function

Private Function Equation(ByVal x As Double, ParamArray params() As Double) As Double

Dim St As Double = params(0)

Dim Ct As Double = params(1)

Dim B1 As Double = params(2)

Dim B2 As Double = params(3)

Dim SumOf_iFi As Double = B1 * x + B2 * 2 * x * x

Dim DegreeOfSaturation = SumOf_iFi / Host.Partition(x, B1, B2)

Return St - x - Ct * DegreeOfSaturation
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End Function

Global Variables and Constants
Dim cellVol As Double

Dim St, Ct As Double

Dim Q, PreviousQ, dQ As Double

Dim XFree, PreviousXFree As Double

Dim TotalCellVolume As Double

Dim _Ka1, _Ka2 As Double

Dim OverfillMode As Boolean

Provided Constants
Private Readonly TitrantmM as Double = 0.1

Private Readonly TitratemM as Double = 1

Private Readonly InitTitrateVol as Double = 950

Private Readonly DefaultInjVol as Double = 5

Private Readonly Temperature as Double = 25

Private Readonly UsingMicroCalorieUnits as Boolean = False

Private Readonly R as Double = 8.3144621
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DSC Model Name: Two State

Main Function
  Dim Y As Double

  T = Temp(iteration) + 273.15

  Tm0 = Tm + 273.15

  dH0 = dH * 1000.0

  K=exp(-dH0*(1-T/Tm0)/(R*T))

  Cp=(dH0 * dH0)/(R*T*T)*exp(dH0*(-Tm0+T)/(Tm0*T*R))/((1+K)*(1+K))

  Y = Cp / 1000.0

  Return Y

Initialization Functions
(none)

Auxiliary Functions
(none)

Global Variables and Constants
  Dim T As Double

  Dim Tm0 As Double

  Dim dH0 As Double

  Dim K As Double

  Dim Cp As Double

Provided Constants
  Private Readonly Volume as Double = 0.3

  Private Readonly Mass as Double = 1

  Private Readonly Conc as Double = 0.1

  Private Readonly MW as Double = 10

  Private Readonly PSV as Double = 0.73

  Private Readonly CalUnits as Boolean = False

  Private Readonly b as Double = 300.96
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  Private Readonly c as Double = -0.4807

  Private Readonly R as Double = 8.3144621

DSC Model Name: Two State Scaled

Main Function
  Dim Y As Double

  T = Temp(iteration) + 273.15

  Tm0 = Tm + 273.15

  dH0 = dH * 1000.0

  K=exp(-dH0*(1-T/Tm0)/(R*T))

  Cp=(dH0 * dH0)/(R*T*T)*exp(dH0*(-Tm0+T)/(Tm0*T*R))/((1+K)*(1+K)) * Aw

  Y = Cp / 1000.0

  Return Y

Initialization Functions
(none)

Auxiliary Functions
(none)

Global Variables and Constants
  Dim T As Double

  Dim Tm0 As Double

  Dim dH0 As Double

  Dim K As Double

  Dim Cp As Double

Provided Constants
  Private Readonly Volume as Double = 0.3

  Private Readonly Mass as Double = 1

  Private Readonly Conc as Double = 0.1

  Private Readonly MW as Double = 10
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  Private Readonly PSV as Double = 0.73

  Private Readonly CalUnits as Boolean = False

  Private Readonly b as Double = 300.96

  Private Readonly c as Double = -0.4807

  Private Readonly R as Double = 8.3144621

DSC Model Name: General

Main Function
  Dim Y As Double

  bbCp = b

  ccCp = c

  Tm0 = Tm + 273.15

  dHTm = dH * 1000

  dCpTm = dCp * 1000

  dSTm = dHTm / Tm0

  acon = dCpTm - bbCp * Tm0 - ccCp * (Tm0 * Tm0)

  T = Temp(iteration) + 273.15

  dCp1 = acon + bbCp*T + ccCp*T*T

  deltah = dHTm+acon*(T-Tm0)+(bbCp*(T*T-Tm0*Tm0)/2)+(ccCp*(T*T*T-Tm0*Tm0*Tm0)/3)

  deltas = dSTm+acon*log(T/Tm0)+bbCp*(T-Tm0)+(ccCp*(T*T-Tm0*Tm0)/2)

  kEQ = Exp(-(deltah-T*deltas)/(R*T))

  qpar = 1 + kEQ

  advh = kEQ * deltah

  advh2 = kEQ * deltah * deltah

  advcp = kEQ * dCp1

  Temp0 = Temp(iteration) + 273.15

  dCp1 = acon + bbCp*Temp0 + ccCp*Temp0*Temp0

  deltah = dHTm+acon*(Temp0-Tm0)+(bbCp*(Temp0*Temp0-Tm0*Tm0)/
2)+(ccCp*(Temp0*Temp0*Temp0-Tm0*Tm0*Tm0)/3)

  deltas = dSTm+acon*log(Temp0/Tm0)+bbCp*(Temp0-Tm0)+(ccCp*(Temp0*Temp0-Tm0*Tm0)/2)

  kEQ = Math.Exp(-(deltah-Temp0*deltas)/(R*Temp0))

  qpar = 1 + kEQ

  advh = kEQ * deltah

  advh2 = kEQ * deltah * deltah
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  advcp = kEQ * dCp1

  hav1 = (advh*advh)/(qpar*qpar)

  hav2 = advh2 / qpar

  Cp = (advcp/qpar) + (hav2-hav1)/(R*Temp0*Temp0)+(A0 + A1 * Temp(iteration)) * MW * 1000

  Y = Cp / 1000

  Return Y

Initialization Functions
(none)

Auxiliary Functions
(none)

Global Variables and Constants
  Dim acon As Double

  Dim T As Double

  Dim deltah As Double

  Dim deltas As Double

  Dim kEQ As Double

  Dim qpar As Double

  Dim advh As Double

  Dim advh2 As Double

  Dim advcp As Double

  Dim Temp0 As Double

  Dim dCp1 As Double

  Dim hav1 As Double

  Dim hav2 As Double

  Dim Cp As Double

Provided Constants
  Private Readonly Volume as Double = 0.3

  Private Readonly Mass as Double = 1

  Private Readonly Conc as Double = 0.1

  Private Readonly MW as Double = 10

  Private Readonly PSV as Double = 0.73
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  Private Readonly CalUnits as Boolean = False

  Private Readonly b as Double = 300.96

  Private Readonly c as Double = -0.4807

  Private Readonly R as Double = 8.3144621

DSC Model Name: Gaussian

Main Function
  Dim Y As Double

  T = Temp(iteration)

  Y = a1*exp(-((T-b1)/c1)^2)

  Return Y

Initialization Functions
(none)

Auxiliary Functions
  Public Function area() As Double

    Return a1*c1*1.772453851 'number is for sqr(PI)

  End Function

Global Variables and Constants
  Dim T As Double

Provided Constants
  Private Readonly Volume as Double = 0.3

  Private Readonly Mass as Double = 1

  Private Readonly Conc as Double = 0.1

  Private Readonly MW as Double = 10

  Private Readonly PSV as Double = 0.73

  Private Readonly CalUnits as Boolean = False

  Private Readonly b as Double = 300.96

  Private Readonly c as Double = -0.4807

  Private Readonly R as Double = 8.3144621
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DSC Model Name: Cooperative
Main Function
Dim Y As Double

T = Temp(iteration) + 273.15

Tm0 = Tm + 273.15

dH0 = dH * 1000.0

dH0cal = Calorimetric_dH * 1000.0

Ka = exp(-dH0cal * (1.0 - T / Tm0) / (R * T))

Cp = Ka * dH0 * dH0cal / ((1.0 + Ka) * (1.0 + Ka) * R * T * T)

Y = Cp / 1000.0

Return Y

Initialization Function
(none)

Auxiliary Function
(none)

Global Variables and Constants
Dim T As Double

Dim Tm0 As Double

Dim dH0 As Double

Dim dH0cal As Double

Dim Ka As Double

Dim Cp As Double
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Provided Constants
Private Readonly Volume as Double = 0.3

Private Readonly Mass as Double = 1

Private Readonly Conc as Double = 0.1

Private Readonly MW as Double = 10

Private Readonly PSV as Double = 0.73

Private Readonly CalUnits as Boolean = False

Private Readonly b as Double = 300.96

Private Readonly c as Double = -0.4807

Private Readonly R as Double = 8.3144621

Private Readonly Calorimetric_dH as Double = 0
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